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Overview

Download files from the fastest site with Go!Zilla.    Go!Zilla is an internet file 
management and retrieval system.    Gather URL links to files that you want to download 
by simply Dragging them from your favorite internet browser or Go!Zilla can Integrate 
with your browser for easy click and download support. You manage and categorize 
your files using an intuitive Explorer-style interface. Instantly see file sizes, estimated 
download times and network connection performance.    You can even add as many 
different locations for a single file as you can find or let Go!Zilla do the work by quickly 
searching FTP archives.    Then when Go!Zilla retrieves the file for you, it checks all 
available locations and delivers the fastest possible connection. Now with Download 
Optimization, GoZilla will intelligently switch between mirror sites to meet your minimum 
transfer speed requirements.
Go!Zilla will even resume a failed download from both FTP and HTTP web sites.
Downloads can be started at any time, or scheduled for later when network traffic dies 
down.
And with SmartUpdate you will be automatically notified of updates and information 
about your favorite programs.

If you’re not downloading with Go!Zilla, you’re not really downloading.
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Frequently Asked Questions

Visit the Monster User Site at http://www.gozilla.com/user/ for the latest additions 
to the FAQ and Troubleshooting

How do I drag and drop files into Go!Zilla?
The easiest way is to set Go!Zilla to either always on top (Window menu/Always On 
Top) or to the droptarget (Window menu/Drop Target).    This way Go will float above 
your browser window.    Click and drag the link to the file that you want to the Go window 
or the Drop Target and release.    If you get a circle with an X through it, that means that 
you are not dragging a valid link.    This is most likely because the link you are dragging 
is accessed through an image or picture and your browser thinks that you want to drag 
only the image, not the link.    Internet explorer 4.0 and higher has solved this problem 
by dragging both the image and its corresponding link and Go will recognize and accept 
the link.    If you are using Netscape or an older version of Internet Explorer or other 
browsers that do not fully feature drag and drop you will need to use clipboard Cut & 
Paste in these situations.    Right click on the link (or image) and select Copy Link 
Location (Netscape) or Copy Shortcut (Internet Explorer).    Then select Paste File from 
Go!Zilla and the link will be added to your file list.

How do I use the Super Link Leecher?
The Super Link Leecher lets you easily gather many files from a web page or an FTP 
site. If you start the Link Leecher while using Netscape, Go!Zilla will automatically 
gather the links and files from the page you are currently browsing. If you are using any 
other browser, enter the web or ftp address you want to leech files from and press the 
Leech button. For example you would enter http://www.gizmo.net/gozilla to leech from 
the GoZilla homepage, or try ftp://ftp.simtel.net to browse a popular FTP file archive.
Select files that you want to add to your download list and click the Add button to add 
them to your collection. You can continue to add multiple files from that address or 
double click on a link from the list and Go!Zilla will show you the links and files on the 
new page or FTP directory. Using the Link Leecher you can gather many files from a 
site or FTP server and add them easily to your file list.

When I download a file, I get "Houston, we have a problem"
That means that Go!Zilla was unable to download the file on that attempt.    This can be 
caused by many reasons ranging from unathorized access, network errors, or maybe 
there are just too many people on the file's server right now and you'll have to try back 
later.    You can see a detailed error message in the file's status display and Go!Zilla will 
keep attempting to download your file up to the number of retry attempts you've set (Go 
menu/Options/Connection).    If you have partially downloaded a file, Go!Zilla will restart 
at where it left off once it can resume the connection.    This means that if you've 
downloaded 10 Megs of that 11 Meg file and then get disconnected, you wont have to 
start over from the beginning.    Go!Zilla will restart the download and get only the 
remaining 1 Meg.    What a timesaver!

Sounds Great! But why are MY downloads never resumed from where I got 



disconnected?
This is because you are going through a proxy server and the proxy does not support 
resuming.    If your proxy doesn't support resume, don't use it unless absolutely 
necessary, it will save you a lot of time in the long run.    If you can resume some 
downloads but not others, then the problem is not your proxy server.    It is the server 
that you are getting the file from that does not support resuming.    More and more web 
servers are supporting file resume, so this situation should be rare.    Go!Zilla will 
resume downloads from BOTH FTP and HTTP sites that support resume.

How can I find out if my proxy server supports resuming or not?
Download a file bypassing your proxy and find a file that will resume. Then change your 
settings to use your proxy and then download the same file again. If it suddenly won't 
resume anymore, then your proxy doesn't support it.

What's this about downloading from the fastest site?
When you add a file to Go!Zilla it will search FTP archives to locate additional sites that 
also have that file (called mirror sites).    Usually, one of these sites will be closer to you 
or just plain faster than the site you originally would have downloaded the file from.    
Go!Zilla will automatically find these sites for you if you have the Auto FTP Search 
option enabled (Go Menu/Options/FTP Search) and will quickly test each site before a 
download to see which one is operating the fastest at that moment.
No more turtle-slow downloads from an unresponsive site.

Cool!    But I always get the message "unable to connect to ..." when Go!Zilla tries 
to find those mirror sites. What do I do?
This means that either that FTP Search engine is not responding right now or is 
responding very slowly. Try increasing your search timeout (Go 
Menu/Options/Connection) or changing to a different search engine (Go 
Menu/Options/FTP Search).

I like how Go!Zilla will select the quickest site for my download, but sometimes I 
want to download from a specific site from the list. How do I do this?
Examine the properties for the file (File Menu/Edit File or right-click file/Edit File).    You 
will see all the mirror sites for that file that Go!Zilla has found.    Select the site you want 
to download from and hit the download button.    Go!Zilla will download your file from 
that site.

How can I get GoZilla to download files one after the other in a single file 
manner?
How can I get scheduled downloads to download single file at my selected time?
You can set how many files GoZilla will download at once from Options/Connection 
under the setting for Max Connections.
This defaults to 2 at a time but if you changed it to 1, GoZilla would download any files 
you select to download one after the other single file. 
So to have a group of files start downloading one after the other at 10PM, you would 
select all the files you want. Hit the schedule button and fill in the time for 10PM. If your 



Max Connections is set to 1, even though all the files are scheduled for 10PM only one 
will download at a time, so after one is finished GoZilla will move to the next one until all 
the files are retrieved.

How do I get GoZilla to download from password protected sites?
You can set up authentication information for protected sites that you download from 
under Options/Security.
Click the Add button to add a site, enter the site name like "www.gozilla.com" and then 
enter your username and password.
Or GoZilla will download from URLs that have the authentication information imbedded 
such as
ftp://username:passsword@ftpsite.com/path/file

TroubleShooting

Go!zilla gives an error for OLEAUT32.DLL or OLEPRO32.DLL at startup.

If you receive errors about OLEAUT32.DLL or OLEPRO32.DLL then your system needs 
a minor file update.
Visit http://www.gozilla.com/gozilla/oleupdate.html for details.

Go!Zilla keeps trying to intercept a file from my browser and I don’t want it to
Go!Zilla can integrate with your browser to intercept browser clicks and will decide 
whether it is a file that you would like to download.
Sometimes you will come across a file that Go!Zilla wants to intercept, but you would 
rather just view it in your browser.
To make Go!Zilla ignore the file, hold and keep the ALT key pressed while you click on 
the link in your browser. Keep the ALT key pressed until the link has started loading from 
your browser.

Go!Zilla is not capturing all downloads from Internet Explorer
First, make sure you have browser integration turned on. Go to the Auto Menu and 
toggle the Browser Integration setting off and on.
If GoZilla still will not pick up the link, then it is probably a redirected link and gozilla is 
unable to get control away from Internet Explorer. You will need to drag and drop the 
link to GoZilla or use copy & paste to get the link into GoZilla and it will be able to 
download it as normal.

When Go!Zills starts up I get an "Unable to create empty document" message
One of GoZilla's data files has become corrupted. This is often a side effect of some 
uninstall managers like CleanSweep.    You will need to go into your GoZilla program 
directory and delete the files filelist.gzl and monitor.dat
Upgrade to v3.1 or later and GoZilla will automatically detect these kinds of problems 
and fix them.



When Go!Zilla starts up I get an "Unknown file format" message
Go!Zilla has tried to convert an older format filelist to the new format and has been 
unsucessful. You can either manually delete your old filelist (usually filelist.gzl in your 
GoZilla directory) or you can "Save As" from the FileList Menu to start a new filelist.

I get "Unable to launch ICMP.DLL" when I run Go!Zilla
You need to install the TCP/IP networking protocol stack.    This is done automatically 
when you install Dial-Up Networking and most other internet services. You can install 
TCP/IP manually from the Control Panel/Network. If you have TCP/IP already installed 
and still receive this message, uninstall TCP/IP and reinstall the TCP/IP stack.

Whenever I try to download I get a message that says "Unable to locate Down.exe 
Make sure it is in your Go!Zilla program directory"
This can be caused by one of two things. First, if you are using the utility tray.exe from 
Microsoft, do not add Go!Zilla to its menu. Tray.exe will change what Go!Zilla knows as 
its own directory and will cause it to be unable to find its components. If you experience 
this problem, simply remove Go!Zilla from the tray utilities menu and it will return to 
normal.
If you are not using tray.exe or a utility like it and you still have this problem, then check 
your Go!Zilla program directory to make sure that Go.exe, Down.exe and all it's 
components are there. If they aren't then reinstall.

Go!Zilla is not saving my file list from session to session.
Go!Zilla saves your file list from one session to the next so that you can collect and save 
files, and resume failed downloads whenever you please. By default, it saves this 
information in a file called filelist.gzl in your Go!Zilla program directory. Make sure this 
file exists and that it is writeable on your system. If not, then use the Save As... 
command from the file menu to save your filelist wherever you choose. Go!Zilla will 
always attempt to load your last known file list.

Go!Zilla crashes when starting in tray at system startup
This is caused by a conflict at startup with certain versions of Windows Messaging that 
is usally installed by Corel products. Just remove Go!Zilla from the system startup by 
selecting Options/System and make sure the checkbox next to “Start in tray at system 
startup” is cleared.

Microsoft Word Program crashes during some Copy & Paste operations when Go!
Zilla is running
Some versions of Microsoft Word do not correctly integrate into the clipboard chain. You 
will need to turn off Go!Zilla’s clipboard monitoring feature. Turn off clipboard monitoring 
from the Auto Menu by deselecting Monitor Clipboard.

Whenever I start up Windows, it is trying to make an internet connection
Microsoft just recently released all the details of this gritty little monster. Seems that 
updated versions of the OLEAUT32.DLL system file are causing conflicts with existing 
installations of some programs. This looks like a problem for Win95/98 users only and 



isn't affecting WinNT users. The most common side effect of these conflicts is that 
windows will try to make an internet connection immediately after starting. You will need 
to go to your original Windows CD and install the OLEAUT32.DLL file to your windows 
system directory.
See the Microsoft website for more information.

While trying to uninstall, I get an "Unable to open Install.log" error
This affects installations under some long filenamed paths. Go to your GoZilla program 
directory and click on the "Unwise.exe" icon to uninstall.



How To Register Go!Zilla

Registration of your copy of Go!Zilla is quick, easy and costs only $24.95 US
Registering Go!Zilla provides you with the following benefits:

· Immediately receive a non-sponsored version without advertising
· Notification of updates to Go!Zilla
· Priority Technical Support
· Helps support the development of Go!Zilla

You can order online at http://www.gozilla.com/gozilla/order/
or by calling Toll Free at 1-800-656-5443
(612) 253-1234 Outside US
(612) 253-8497 FAX

or By Mail:
Print out the order form and fill out your name, address
and email address.    Mail the form along with $24.95 in cash, check (payable to 
Radiate, Inc) or money order to:

Radiate, Inc
Go!Zilla Registration
1916 Old Middlefield Way
Mountain View, CA 94043



                                  Go!Zilla Registration

Registering Go!Zilla provides you with the following benefits:

Immediately receive a non-sponsored version without advertising.
Notification of updates to Go!Zilla.
Priority technical support
Helps support the development of Go!Zilla.

To register Go!Zilla, print out this page or the orderfrm.txt 
document, fill in your address and send this form along with
$24.95 in cash, check (payable to Radiate, Inc) or moneyorder
to:

Radiate, Inc
Go!Zilla Registration
1916 Old Middlefield Way
Mountain View, CA 94043

Name: _________________________________________

Address: _________________________________________

_________________________________________

_________________________________________

Email: _________________________________________

Thank you for registering Go!Zilla.

For your convenience, Go!Zilla can be ordered online at
http://www.gozilla.com/gozilla/order
or by calling Toll Free at 1-800-656-5443
See README.TXT for details.



Adding Files to Download

Files can be added to Go!Zilla manually, through automated browser integration, by 
dragging a file link from your internet browser or by simply copying a link while Go!Zilla 
is monitoring the clipboard and the link will be automatically added to your list of files.

Entering a File Manually

Select Add File from the File menu.    The URL Dialog will appear.    Here you can enter 
the location of a file you want to retrieve.    You may also type in a description to identify 
the file.

Browser Integration

Go!Zilla can integrate with Netscape v3.0 or higher and Internet Explorer v4.0 and 
higher for easy click and download support. Simply browse using your intenet browser 
and when you find a file you want to download, juck click the link like you normally 
would. Go!Zilla will intercept the file and add it to it’s download list. You can download 
the file immediately or save it for later retrieval.
Toggle browser integration on and off from the Auto menu. You can specify which types 
of files Go!Zilla should intercept from Options/Automation.

**IMPORTANT NOTE**
If Go!Zilla is intercepting a link that you click in your browser as a download that you 
don’t really want Go!Zilla to handle, Browser Integration can be temporarily disabled for 
that link by holding down the ALT key as you click on the link in your browser.
Hold down the ALT key and keep it pressed as you click the link in your browser and 
Go!Zilla will not attempt to intercept it as a download.

Drag and Drop

Click on a link to the file you want to download and drag it to the Go!Zilla file list window 
or the Drop Target.    Release the mouse button and the file will automatically be added 
to your list.    Set the Show Download Info Box and Always on Top options to drag and 
drop at monstrous speeds.

Clipboard Monitoring

Enable clipboard monitoring (Auto menu/Monitor Clipboard) and Go!Zilla will 
automatically add files as you copy them to the clipboard.    Right click on the link of the 
file you wish to download and select Copy Shortcut (Internet Explorer) or Copy Link 
Location (Netscape) and it will be added to your file list.

Pasting a File from the Clipboard

Copy a link to the file you want in your browser.    To paste the file into Go!Zilla, select 



Paste File from the File menu, press the Paste File toolbar button, or select Paste File 
from the right-click context menu on either the Go!Zilla main window or the Drop Target 
window.

Tips

To quickly grab links from your browser and add them to Go!Zilla, set Go!Zilla to either 
Always on Top or to the Drop Target.    Click and drag links to files you want to add to the 
Go!Zilla window or the drop target and release.    Add as many links to alternate sites for 
the file as you can find or let Go!Zilla’s automatic FTP Search find them for you.
When dragging a link that is “behind” an image, some browsers think you are dragging 
the picture and completely disregard the link behind the image.    To get the link, right 
click on it and select Copy Shortcut (Internet Explorer), Copy Link Location (Netscape) 
or whatever command will make your browser copy the link to the file you want to the 
clipboard.    Then paste the link into Go!Zilla.



Downloading

Select any files you want to download.    See Selecting Files.

To start downloading immediately select Download from the Go menu.

To schedule a download for later select Schedule from the Go menu.

When a download starts either from an immediate download or from a scheduled event, 
it is first Queued. Downloads will be moved from the Queue and start downloading if 
there are connections available. You can set the maximum number of simultaneous 
downloads you want from Options/Connection.
Or you can set the maximum number of simulaneous downloads for within a specific 
category. This can be handy for sites that only allow one login at a time. Make a 
category for files from that site, then set the category’s maximum simultaneous 
downloads to one.

You can set a specific time that all downloads will be stopped and your connection will 
be closed. This is handy for ensuring that you are offline when rates increase. Set your 
download cutoff/hangup time under “Set Stop Downloads/Hangup Time” from the Auto 
menu.
You can toggle this feature on and off by selecting or deselecting “Stop 
Downloads/Hangup At…” from the Auto menu.

Selecting Download All will download all files that you have in your file list.

You can stop an individual download by pressing the CANCEL button on the download 
window or by selecting the file in your filelist and choosing “Stop Download” from the 
File menu or the right-click context menu.

You can stop all downloads by selecting “Stop All Downloads” from the Go menu or by 
hitting ALT+F5. This command will also clear out all Queued or Downloading status of 
all files.



Categorize Your Files

You can easily categorize your files by directly dragging them from your browser to any 
of your defined categories listed on the drop target.    Or select files and move them 
between categories using the Category Menu/Place In command or drag them from one 
category to another.

File attributes can be overriden for an entire category of files including control over file 
directory placement, download priority, download retry attempts, and how files are 
treated when they are added to a category.
CATEGORY OPTIONS WILL OVERRIDE GLOBAL OPTIONS FOR ALL FILES IN THAT 
CATEGORY.

You can add new categories with the Category Menu/Add Category command or create 
new categories on the fly as you add files from the Download Info dialog. Once you 
have created various categories for your files, simply drag new files to the Drop Target 
and drop them in the category you wish the file to be added to.
You can also specify that certain types of files should be automatically added to a 
category. Enter a list of file extensions into the add files of type box and then files of 
those types will be automatically added to that category. For example, you might create 
a category called “Images” and specify types “GIF JPG TGA” to be automatically added 
to “Images.”



Scheduling a Download for Later

With Go!Zilla you can schedule files to download later.

First select any files you want to schedule for download.    See Selecting Files .

Set a time and date for the download using the Schedule command from the Go menu. 
Leave Go!Zilla running and your downloads will start at the scheduled time.

You can also set files to be downloaded at certail intervals.    Enable recurring download 
and set how often you want the file to be downloaded.    For example, to get a stock 
update page every fifteen minutes, schedule the file to download and set Recurring 
Download for every 15 minutes.
You can specify that a recurring download should overwrite the previously downloaded 
file or to timestamp the filename so that you will have a list of date and time ordered 
copies of the file as it changes.

You can set a specific time that all downloads will be stopped and your connection will 
be closed. This is handy for ensuring that you are offline when rates increase. Set your 
download cutoff/hangup time under “Set Stop Downloads/Hangup Time” from the Auto 
menu.
You can toggle this feature on and off by selecting or deselecting “Stop 
Downloads/Hangup At…” from the Auto menu.



Smart Restart

Go!Zilla’s Smart Restart will resume a failed download from the point of error so you 
don’t have to start a download over from the beginning.    Smart Restart works with both 
FTP and HTTP sites that support download resume.    Smart Restart will automatically 
keep track of files that can be resumed and sites that support resume.    Whenever you 
see the Smart Restart symbol next to a file, you know you can restart the file’s 
download from the point of error.    When you see the symbol next to a download site, 
that site is known to support download resume.



Super Link Leech

The Super Link Leecher lets you easily gather many files from a web page or an FTP 
site. If you start the Link Leecher while using Netscape or Internet Explorer, Go!Zilla will 
automatically gather the links and files from the page you are currently browsing. If you 
are using any other browser, enter the web or ftp address you want to leech files from 
and press the Leech button. For example you would enter http://www.gizmo.net/gozilla 
to leech from the GoZilla homepage, or try ftp://ftp.simtel.net to browse a popular FTP 
file archive.

Select files that you want to add to your download list and click the Add button to add 
them to your collection. You can continue to add multiple files from that address or 
double click on a link from the list and Go!Zilla will show you the links and files on the 
new page or FTP directory. Using the Link Leecher you can gather many files from a 
site or FTP server and add them easily to your file list.



SmartUpdate

Using SmartUpdate you can monitor your favorite files for updates and enhancements. 
To monitor a file, select the file and choose SmartUpdate Monitor from the File menu or 
the right-click context menu.
SmartUpdate monitors files in two different fashions:

1. Automatically using the Download Management Protocol (DMP). DMP is a method of 
communication between Go!Zilla and a software archive. When updates or 
announcements of interest become available for a monitored program, you will receive 
the announcement and a link back to the originating site where you can get the update 
or find more information about the announcement.

2. Manually by monitoring the file and it’s originating location for any changes.

When Go!Zilla detects that a file has been updated or an announcement is available it 
will place an icon next to the file. Double click the file to see the latest announcements 
or click the View New button to see all new announcements for all the programs your 
are monitoring.
Each announcement will give you a description of the change or update along with a 
link to the updated file or a location to get more information. Click the link to get the 
updated file or information or click the homepage link to go to the net location where the 
file was orignially found.

Visit the Monster User Site at http://www.gozilla.com/user/ for the latest 
information about SmartUpdate and the Download Management Protocol (DMP)



Download Optimization

Go!Zilla will intelligently switch between mirror sites to meet your minimum transfer 
speed requirements. The intelligent site switching will never compromise the integrity of 
your final download.
You can set your minimum speed requirements under Options/Speed. The acceptable 
speed you enter is a guide and will be adjusted according to your actual transfer speed 
and number of downloads currently in progress. This value can be set surprisingly high 
due to GoZilla’s intelligent optimization.

Site switching can be temporarily disabled for any downloading file by deselecting the 
checkbox for site switching on the download window.



Selecting Files in the File List

To select a single file, click on the file’s name.    To select multiple files, hold down the 
CTRL key while clicking on additional files.    To select a range of files, click on the first 
file’s name, then hold SHIFT while clicking on the last file’s name.



File List menu commands

The File List menu offers the following commands:

New File 
List

Create a new file list.

Open File 
List

Open an existing file list from disk.

Save File 
List

Save the current file list to disk.

Save As Save the current file list to disk using a different filename.

Add File Manually adds a URL file to the file list.

Leech 
Files

Leech groups of files from an FTP server or web page.

Find File Search the net for a particular file.

Paste File Paste a file URL from the clipboard to the list.

Remove 
All

Removes all URLs from the file list.

Import 
Broken 
Download

Imports a failed download from another program to be resumed by 
Go!Zilla. You must specify the location of the broken file on your 
local system, and the net location where it should be resumed 
from.

Exit Exits Go!Zilla.



File menu commands

The File menu offers the following commands:

Download Download selected files now.

Schedule Schedule selected files for download later.

Clear 
Schedule

Clear scheduled download times for selected files.

Edit Edit a file’s download properties.

Launch Launch, execute or display a downloaded file.

Visit 
Homepage

Visit the file's original network HomePage.

Explore Explore file location on your local disk.

Delete 
From Disk

Deletes selected downloaded files from your disk.

FTP 
Search

Searches FTP sites for more locations for a selected file.

Export 
DMP 

Export File Information into Download Management Protocol 
(DMP) Format

Smart 
Update 
Monitor

Automatically monitor your favorite programs for updates and 
announcements.

Remove 
File

Removes selected file or files from the file list.



Go menu commands

The Go menu offers the following commands:

Download Download selected files now.

Download 
All

Download all files in the list now.

Stop All 
Downloads

Stop all current downloads and remove all files from the download 
queue.

Unqueue 
All

Stops All Transfers after Currently Downloading Files Finish. 
Removes all files from the download queue.

Pause All Pause All Downloads.

Resume 
All

Resume All Paused Downloads.

Stop 
Download

Stop selected Current Downloads.

Smart 
Update

View Monitored Updates & Announcements.

View Log View the log of download results.

Clear Log Clears the log of download results.

Options Set Go!Zilla Options and Preferences.
View menu commands

The View menu offers the following commands:

View Style Set the View style for the main window.    Can be either 
Large Icons, Small Icons, List View or Detail View.

Sort Sort by file properties.

Auto 
Arrange

Toggles automatic icon arranging on and off.

Grid Toggles the filelist grid lines on and off.

Toolbar Shows or hides the toolbar.



Graph Shows or hides the performance graph.

Status Bar Shows or hides the status bar.
Category menu commands

The Category menu offers the following commands:

Add 
Category

Create a new file list category.

Place In Moves any selected files to the specified category.

Show List files from the specified category.    Select All to 
show all files from all categories.    Select No Category 
to show files that have not been categorized.

Edit Edit properties for the specified category.

Delete Delete the specified category.

Explore Explore the category’s local file location

See Categorizing your files for more details.



Auto menu commands

The Auto menu offers the following commands:

AutoSave 
FileList

Toggle Auto Saving your Filelist on and off. When 
enabled, your filelist will be automatically saved every 
several minutes. You can set the frequency of 
autosaving under Options/Automation.

Disconnec
t

Toggle Auto Disconnect on and off. When enabled, 
Go!Zilla will disconnect from your internet service 
provider when it is finished downloading a group of 
files.

Shut 
Down

Toggle Auto Shut Down on and off. When enabled, 
Go!Zilla will logout and shut your system down when it 
is finished downloading. It will also power off your 
computer if it’s power management supports 
shutdown.

Browser 
Integration
on

Togge Browser Integration on and off. When browser 
integration is enabled, any downloadable files that you 
click on in your browser will be automatically captured 
for download using Go!Zilla.

Monitor 
Clipboard

Toggle the Clipboard Monitor on and off.    When 
clipboard monitoring is enabled, any valid file link 
copied to the windows clipboard will be automatically 
added to your Go!Zilla file list. Handy for quickly 
grabbing large numbers of files quickly.

Virus 
Scan

Toggle Auto Virus Scanning on and off.    When virus 
scan is enabled, all incoming files will be sent through 
your virus scanner.    See Automation Options for 
details on setting your virus scanner options.

Stop 
Download
s/Hangup 
At..

Toggle the Stop All Downloading and Hangup Time on 
and off.

Set Stop 
Download

You can set a specific time that all downloads will be 
stopped and your connection will be closed. This is 



s/Hangup 
Time

handy for ensuring that you are offline when rates 
increase. Set your download cutoff/hangup time.



Window menu commands

The Window menu offers the following commands:

Always On 
Top

Toggles Always On Top

Drop 
Target

Make the Go!Zilla window a small drop target.

Tray Icon Minimize Go!Zilla to the system tray.

No 
Download 
Windows

Toggle showing individual download windows. You 
can watch the progress of your downloads either from 
a separate download window or from the main file list 
window.

Minimize 
Download 
Windows

Toggle minimized/maximized download windows.

Use 
Sounds

Toggle sound effects on and off. You can individualize 
your Go!zilla sounds under your Windows Control 
Panel/Sounds.



Help menu commands

The Help menu offers the following commands, which provide you assistance with Go!
Zilla:

Help 
Topics

Offers you an index to topics on which you can get 
help.

About Displays the version number of Go!Zilla.



Add File command (File menu)

Use this command to manually add a new URL file to the file list.    The URL Dialog will 
appear where you can enter a URL location and description for the new file.

Shortcuts
Toolbar: Click the Add File toolbar button.
Keys: INS

See Also: Drag and Drop URL for automatic URL drag and drop operations.



Find File command (File menu)

Search the net for a specific file.    Enter the filename or keyword you are looking for and 
hit the search button.    Any matching files will be displayed in your browser where you 
can drag and drop or copy and paste them to Go!Zilla.



Paste File command (File menu)

Use this command to paste a URL file to the file list from the clipboard.

Shortcuts
Toolbar: Click the Paste File toolbar button.

See Also: Drag and Drop URL for automatic URL drag and drop operations and file 
paste tips.



Edit Description command (File menu)

Use this command to edit the selected URLs description. The Download Info Box will 
appear where you can edit the description for the file.

Shortcuts
Toolbar: Click the Edit Description toolbar button.
Keys: CTRL+E



Remove File command (File menu)

Use this command to remove all selected URLs from the file list.

Shortcuts
Toolbar: Click the Remove File toolbar button.
Keys: DEL



Remove All command (File menu)

Use this command to remove all the URLs from the file list.

Note: You will be asked to verify this selection.



FTP Search command (File menu)

This command uses FTP search engines to locate more mirror sites for the selected file. 
When Go!Zilla downloads a file, it will perform a speed check of all known mirror sites 
and select the site that is operating at the quickest speed.    The more mirror sites Go!
Zilla can collect for a file, the better your chances of maximizing your download speeds.



Exit command (File menu)

Use this command to end your Go!Zilla session.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Download command (Go menu)

Use this command to start downloading any selected URLs.

Shortcuts
Toolbar: Click the Download toolbar button.
Keys: CTRL+D



Download All command (Go menu)

Use this command to start downloading all URLs files in the list.



Schedule command (Go menu)

Use this command to schedule any selected URLs.    The Schedule Dialog will appear 
where you can set the date and time you want the files to start downloading.

Shortcuts
Toolbar: Click the Schedule toolbar button.



Clear Schedule command (Go menu)

Use this command to clear the scheduled time for any selected URLs.



Options command (Go menu)

Use this command to set Go!Zilla options and preferences.    See Options for a list of 
Go!Zilla options.



Always On Top command (Window menu)

Toggles the Go!Zilla window to Always on Top.    If enabled, the window will float above 
your browser window.



Drop Target command (Window menu)

Switches the Go!Zilla view window to the Drop Target.    The Drop Target is a small 
window that floats above your browser.    To add files to Go!Zilla just drag the link from 
your browser to the Drop Target.    The Drop Target can be positioned wherever you like 
by dragging it with the mouse.



Tray command (Window menu)

Minimizes Go!Zilla to the system tray.    Click on the tray icon to paste files to Go!Zilla or 
to restore to the full window.    Go!Zilla will monitor the clipboard from the tray (with 
Monitor Clipboard enabled) for transparent operation.



Go!Zilla Options

Go!Zilla options and preferences are grouped into several categories:

Connection Connection setup, Username and 
Password, and download preferences.

Files Download directory and file list 
preferences.

FTP Search FTP Search preferences.

System General Go!Zilla preferences.

Automation Automation and virus scan 
preferences.

Security Set your usernames and passwords on 
a site-by-site basis.

Performance Graph Preferences about how you would like 
the performance graph to display.

Dial-Up Networking Settings to correctly enable Automatic 
Dial Up Networking support.

Speed Settings that control download 
optimization and bandwidth throttling.



Connection Options

Speed
Connection speed.    Choose your connection speed from the drop-down list. If 
your speed is not listed, select Other and enter your connections speed in bps 
(bits per second)

Max Simultaneous Downloads
Select the maximum number of simultaneous connections you want Go!Zilla to 
use.    For example, if you have 4 files selected for download and a maximum of 2 
connections, only 2 files will download at any one time.    The others will be 
queued for download after a connection becomes available.    Best performance 
is maintained with a maximum of 2 or 3 connections, but this can vary based on 
network performance.

Retry
Select the maximum number or retries for a single download.    If an error occurs 
during a file transfer, Go!Zilla will attempt to get the file again.    Set this option to 
the number of times you want to retry a failed download.

Timeout
Timeout values in seconds

Proxy Server
Check the use proxy server box if you must go through a proxy or firewall.    Enter 
the proxy address and port to use.    You will need to obtain these values from 
your network administrator. 
You can enter separate proxies for HTTP and FTP transfers or use one proxy for 
both by checking the FTP Proxy Use HTTP Proxy button.
If you are using a separate FTP proxy, enter it’s address, port and transfer mode. 
Experiment with the different modes until you find the one that works with your 
proxy.
Enter a UserName and Password for proxies that require login.

Note: If your proxy does not support download resume, none of your downloads 
will be resumable.    If you have such a proxy, don’t use it unless absolutely 
necessary for security.    You will save a lot of time in the long run.



Setup

Speed
Connection speed.    Choose your connection speed from the drop-down list. If 
your speed is not listed, select Other and enter your connections speed in bps 
(bits per second)

Dial-Up Networking
Dial-Up Networking settings allow the Go!Zilla dialer to operate correctly when 
connecting to the internet to download and to disconnect once your downloads 
are complete.

Connect To
Select the connection from the dropdown list that you use to connect with your 
Internet Service Provider. If you are using a direct network connection or would 
prefer to use a dialer other than the Go!Zilla dialer select “No-Dial Up”

Username/Password
Enter your username and password information to log into your Internet Service 
Provider. If you do not provide a username and password, and one is required, 
then you will be prompted to enter this information every time the dialer needs to 
log into your provider.

Proxy Server
Check the use proxy server box if you must go through a proxy or firewall.    Enter 
the proxy address and port to use.    You will need to obtain these values from 
your network administrator. 
You can enter separate proxies for HTTP and FTP transfers or use one proxy for 
both by checking the FTP Proxy Use HTTP Proxy button.
If you are using a separate FTP proxy, enter it’s address, port and transfer mode. 
Experiment with the different modes until you find the one that works with your 
proxy.

Enter a UserName and Password for proxies that require login.

Note: If your proxy does not support download resume, none of your downloads 
will be resumable.    If you have such a proxy, don’t use it unless absolutely 
necessary for security.    You will save a lot of time in the long run.



File Options

Show Download Info Box
Select this option to be automatically prompted to enter a file description when 
you Drag and Drop a new file into Go!Zilla.    This option can be handy to quickly 
label batches of new files as you grab them from your browser.    To disable the 
Download Info Box from appearing when you add new files, disable Show 
Download Info.

Remove Files after Success
Select this option to automatically remove files from the file list after a successful 
download.

Get File Sizes
Select this option to have Go!Zilla try to find the size and estimated download 
time of any files you add.

No Download Windows
Turns off individual download progress windows.

Minimize Download Windows
Makes the download windows start in the task bar and do not pop-up when 
started. Use this for a quiet “background” style download session.

Favor Smart Restart Sites
Go!Zilla supports failed download resume for both FTP and HTTP.    It also 
maintains a dynamic database of sites known to support smart restart.    This 
slider lets you select by how much Go!Zilla will favor these known sites when 
making it’s download site choice.    The higher the %, the more these sites will be 
favored.    While setting the favor percentage very high will guarantee that known 
smart restart sites are selected, this may force Go!Zilla to bypass a faster site 
that does support restart but has not yet been added to the database.

Default Download Directory
Enter the default directory where you want Go!Zilla to store your downloaded 
files.

Note: Many of these global file options can be overriden by a file’s category options if 
the file is placed into a category.



Speed Options

Download Optimization
Select your minimum acceptable download speed. GoZilla will intelligently switch 
between mirror sites to meet your minimum transfer speed requirements. The 
intelligent site switching will never compromise the integrity of your final 
download.
The acceptable speed you enter is a guide and will be adjusted according to your 
actual transfer speed and number of downloads currently in progress. This value 
can be set suprisingly high due to GoZilla’s intelligent optimization.

Global Throttle
Set the maximum percentage of your total transfer bandwidth (available network 
speed) that will be used by all downloads.

Default Individual Download Throttle
Set the maximum percentage of your total transfer bandwidth (available network 
speed) that will be used by each individual file.

Throttles can be used to limit how much of your network connection is being used for downloading. For 
example, you can throttle down while surfing to reserve more bandwidth for viewing web pages.



FTP Search Options

FTP Search uses internet search engines to find even more alternate sites for a file.    
The more sites Go!Zilla has for a file, the more likely it is to find the quickest possible 
site to download your file from.

Primary, Alternate 1, Alternate 2
Select the sites you want to use as Go!Zilla’s FTP Search engine.    Pick one of 
the sites from the drop down list or enter the address of an FTP Search site for 
each selection. The primary site will be searched first with the Alternate 1 & 
Alternate 2 sites used as backup FTP Search resources.

Domains
This limits the FTP mirror sites for the file that Go!Zilla will add.    Only sites within 
the domain or domains that you specify will be added.    Select domains from the 
drop down list or enter domains manually.    If you enter more than one domain 
manually, separate domain names with a colon.

Max Hits
Limit the number of sites added for a file.

Exact Size
If exact size is enabled, a file must be the exact same size as the original file in 
order to be added.

Suppress Search Status
If enabled, the results of FTP Searches will not be displayed.    Alternate sites will 
be added without reporting.

Auto Search On New File
Specifies when you want Go!Zilla to attempt to find alternate mirror sites for a file 
that you have added.    Choices are:
Never:    Don’t perform an automatic FTP search for added files.
Always:    Always perform an automatic FTP search when a new file is added.
File Size Known:    Go!Zilla will wait until an exact file size is known for the added 
file before performing an automatic FTP search.    This option works best with 
Exact Size enabled to guarantee that mirror sites selected contain an exact copy 
of the file added.

Reject Mirror Locations
Enter sites here that you want to block from being listed as mirror locations. Enter 
a list of site names such as ftp.gizmo.net.



System Options

Start As
Select the way you would like the Go!Zilla window to appear when it is started.    
Choose from:
Normal:    Start Go!Zilla using it’s standard view window.
Minimized:    Start Go!Zilla minimized.    The main window will not appear, but you 
can access Go!Zilla from it’s task bar icon.
Drop Target:    Start Go!Zilla as the Drop Target.    The Drop Target is a small 
window that floats above your browser.    To add files to Go!Zilla just drag the link 
from your browser to the Drop Target.    The Drop Target can be positioned 
wherever you like by dragging it with the mouse.
Tray Icon:    Start Go!Zilla as a minimized icon in your system tray.

Place in Tray on System Startup
Toggle whether you want Go!Zilla to startup in your system tray whenever 
windows is started.

Launch Browser On Startup
Select this option to have Go!Zilla automatically launch your browser whenever 
Go!Zilla is manually started.
Select your startup homepage by entering it’s address.

Check for SmartUpdate Announcements
Toggle whether Go!Zilla will automatically check for new SmartUpdate 
announcements for programs you are monitoring. Set the frequency of checking 
by specifying how many hours between checks.

Always on Top
Select this option to make Go!Zilla stay above all other windows.    This is useful 
when doing Drag and Drop operations from your browser.

Use Sounds
Select this option to have Go!Zilla use sounds to notify you of events such as 
adding a file, or download success and failure.    The sounds can be modified 
from the windows control panel.

Animation
Select this option use animation for visual confirmation when a file is added to the 
Drop Target.

Use HTTP Smart Restart
Go!Zilla supports smart restart to resume failed downloads for both FTP and 
HTTP.    However, the restart technology for HTTP is still fairly new and is only 
implemented by some servers using new or beta software.    Because of this, the 
HTTP restart may not behave as expected when dealing with some servers.    If 



you are having problems with HTTP restart, disable this option.



Automation Options

Auto Save FileList
When enabled, will automatically save your filelist every several minutes. Enter 
how often you would like to automatically save.

Auto Disconnect
Select this option to enable Automatic Disconnect.    When enabled, Go!Zilla will 
disconnect from your internet service provider when it is finished downloading a 
group of files.

Auto Shut Down
Select this option to enable Automatic System Shut Down.    When enabled, Go!
Zilla will logout and shut your system down when it is finished downloading. It will 
also power off your computer if it’s power management supports shutdown.

Browser Integration
Go!Zilla can integrate with Netscape, Internet Explorer and Mosaic based 
browsers for easy click and download support. Simply browse using your intenet 
browser and when you find a file you want to download, juck click the link like you 
normally would. Go!Zilla will intercept the file and add it to it’s download list. You 
can download the file immediately or save it for later retrieval.
Toggle browser integration on and off. You can specify which types of files Go!
Zilla should intercept by file extension (Internet Explorer) and MIME type 
(Netscape).
Browser Integration can also be quickly turned on and off from the Auto menu.

**IMPORTANT NOTE**
If Go!Zilla is intercepting a link that you click in your browser as a download that 
you don’t really want Go!Zilla to handle, Browser Integration can be temporarily 
disabled for that link by holding down the ALT key as you click on the link in your 
browser.
Hold down the ALT key and keep it pressed as you click the link in your browser 
and Go!Zilla will not attempt to intercept it as a download.

Clipboard Monitoring
Enable clipboard monitoring and Go!Zilla will automatically add files as you copy 
them to the clipboard.    Right click on the link of the file you wish to download and 
select Copy Shortcut (Internet Explorer) or Copy Link Location (Netscape) and it 
will be added to your file list.
You can specify certain file types that will be ignored by the clipboard monitor.

Virus Check
Select this option use automatic virus checking on all incoming files.    Enter your 
virus scanner into the Virus Scanner field and enter any command line options for 
the scanner into the Scanner Options field.    When Virus Check is enabled, all 



downloaded files will be automatically passed to your virus scanner for validation.



Security Options

Specify any needed authorization for sites you download from.    Click the Add button to 
add new site authorization.    From the dialog, enter the site name (for example, 
www.microsoft.com or ftp.gizmo.net) and your username and password for that site.    
Whenever you download from a site in your security list and authorization is required, 
Go!Zilla will send your username and password to verify your identity for download.



Performance Graph

Specify your preferences for how you want the performance graph to display.

Maximum Display
Set the maximum graph display in kilobytes/second.

Label Every
Increment between each label line. For example, specifying label every 1 K/s will label 
the graph with a marker line at every kilobyte/second mark.

Sample Every
How often you want the graph to be updated. Set anywhere from updates every 1 
second to every 10 seconds.

Graph Colors
Select your own custom colors for the graph background, labeling, and plotting color.



Dial-Up Networking

Dial-Up Networking settings allow the Go!Zilla dialer to operate correctly when 
connecting to the internet to download and to disconnect once your downloads are 
complete.

Dial-Up Connection
Select the connection from the dropdown list that you use to connect with your 
Internet Service Provider. If you are using a direct network connection or would 
prefer to use a dialer other than the Go!Zilla dialer select “No-Dial Up”

Retry Connection
Enter the number of times you want to redial the connection if there is a problem 
connecting. i.e. busy signals, no answer, etc.

Username/Password
Enter your username and password information to log into your Internet Service 
Provider. If you do not provide a username and password, and one is required, 
then you will be prompted to enter this information every time the dialer needs to 
log into your provider.

Connection Interrupted Window Title
Enter the window title for the Dial Up Networking implementation you are using. 
Enter the window's caption exactly as it appears to correctly enable Auto DUN 
functionality.
Connection Interrupted Window
This is the window that appears when the connection has been unexpectedly 
dropped. Usually, it will prompt you to reconnect or to cancel.



URL (Uniform Resource Locator)

A file’s URL tells Go!Zilla where to find it on the internet.    URLs can be entered 
manually using the Add File command from the File menu or by Dragging and Dropping 
a URL from your internet browser.    You can add multiple URLs for the same file.    In 
this case, Go!Zilla will query each URL at download time and use the fastest possible 
connection to the file.

URLs generally take the following forms:
http://www.someplace.com/file
ftp://ftp.someftp.com/file



Drag and Drop Files

You can quickly add files to Go!Zilla using drag and drop.    Drag any URL link from your 
favorite browser to the Go!Zilla file list.    If the URL points to a new file, it is added to the 
list.    If the URL points to an alternate location for an existing file, Go!Zilla adds that 
location to the file’s server location list.    Drag and drop makes it easy to quickly add 
many files with several possible server locations to Go!Zilla.    When you are ready to 
download, Go!Zilla will find the fastest connection to the files you want.

When using drag and drop you may find it useful to select the Show Download Info Box 
and Always on Top options.



Setting a Download Schedule Time

The Schedule dialog is where you set the date and time of future downloads.    Click on 
the portion of the date/time that you want to change, then use the up and down spinner 
arrows to increase and decrease the date value.



Download Info Dialog

The Download Info dialog is where you can edit and maintain a file and it’s URL location 
sites.

The File section shows the file’s name, description, size and estimated download time. 
Use the Save As button to set the location that you would like the file saved.    If you do 
not specify a Save As location, the file will be downloaded to the default download 
directory.

The Host Machine section shows the internet URL sites that contain this file and current 
statistics for those sites.
Hops is the number of router jumps from you to the site.
Trip is the average time in milliseconds for information to travel from you to the site and 
back.
Loss is the percentage of information that was lost in transfer and would be resent, 
effectively lengthening the download time.    Loss is a measure of the stability of the 
connection between you and the target site.
Status is an informational message about the current site’s performance.

Pressing the Download button will start downloading the file.    If a single site is not 
selected in the Host Machine window, Go!Zilla performs a site evaluation and chooses 
the best site for the download.    If one site is selected, that site is used for the 
download.
Pressing the Schedule button lets you enter a time that the file will be automatically 
downloaded.
Pressing the Find button attempts to find more mirror sites for this file.    See FTP 
Search.
Pressing the Add button will let you manually add another site for this file.
Pressing the Remove button will remove any selected sites for this file.



Entering and Editing a URL

The URL dialog is where you tell Go!Zilla the URL location for a file.    Enter the location 
of the file using standard URL format.

The URL dialog also lets you add or edit a description for a file.    Enter anything here 
that will help you identify the file.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of 
the most common commands in Go!Zilla, such as Add File and Download.    A check 
mark appears next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    
The toolbar provides quick mouse access to many tools used in Go!Zilla,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch 
state. A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Go!Zilla window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow 
keys to navigate through menus.    This area similarly shows messages that describe the 
actions of toolbar buttons as you depress them, before releasing them.    If after viewing 
the description of the toolbar button command you wish not to execute the command, 
then release the mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, 
you can jump to step-by-step instructions for using Go!Zilla and various types of 
reference information. 

Once you open Help, you can click the Contents button whenever you want to return to 
the opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
Go!Zilla.



Context Help command 

Use the Context Help command to obtain help on some portion of Go!Zilla.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow 
and question mark.    Then click somewhere in the Go!Zilla window, such as another 
Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the 
application.

To move the window, drag the title bar.    Note: You can also move dialog boxes by 
dragging their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes 
inside the scroll bars indicate your vertical and horizontal location in the file list.    You 
can use the mouse to scroll to other parts of the file list.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window 
with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the 

pointer to the border you want to move. 
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window 
or dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Go!Zilla window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Go!Zilla determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Go!Zilla 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the Go!Zilla window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose 
the Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to 
switch to or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with 
the following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This 
option does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.





No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.




